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1. Introduction 

This chapter provides an overview of this guide 
including conventions used. The following chapters 
are included: 
• Chapter 1, Introduction 
• Chapter 2, Basic Concepts 
• Chapter 3, FreeFlow Makeready for Copyright 

Management  
• Chapter 4, Copyright Management Service Admin 

Application & Copyright  Management Search 
Application 

• Chapter 5, Copyright Management Service: 
CCMOrder.exe 

• Chapter 6,  Database Utilities 
• Chapter 7, Error Messages and Remedial Actions 
• Chapter 8, Multiple CMS Client Configuration 
• Chapter 9, Appendix :Field Names and Usage 

About this Guide 

This guide contains instructions for using Xerox 
FreeFlow Makeready with Copyright Management 
Service. 

Before performing any procedures in this guide, 
become familiar with its contents and conventions. 

 



Introduction   Copyright Management 

Copyright Management User Guide  1-2 

Conventions Used in this Document 

The FreeFlow Makeready Copyright Management 
Service User Guide uses the following conventions: 

Convention Description 

Bold Boldface type is used for the following:  
– Directory paths; for example, “Browse to Win_nt40/ Xeroxdrv”  
– Text that is typed; for example, "Type purple or red."  
– Calling attention to text that is particularly important; for example, 

“Select Stop on the user interface window. Do not press the red 
stop button on the controller.”  

–      Words on the screen 

< >   Variable information that is displayed on the screen or that can be 
entered as part of a command line is enclosed within angle brackets. 
Examples include "Unable to copy <filename>;" “set –p <printer>.” 

Italics Document and library names are shown in italics; for example:  
Refer to the Security Compliance Audit Tool. 

> Indicates flow of steps required to complete an action; for example: 
Click Insert > Picture > From File. 

NOTE: Notes are hints that assist with performing a task or 
understanding the text. Notes are presented in italics in separate 
paragraphs, as shown here. 

Printing this Document 

This document includes blank pages that paginate 
correctly with duplex printing.  
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2. Basic Concepts 

This chapter shows a system diagram and explains a 
basic concepts and terminology. The copyright 
management functionality is divided as follows: 
• Copyrights Order Entry is done thru Xerox 

FreeFlow Makeready. This is described in Chapter 
3. 

• Copyrights Order Reporting & Management is 
done thru Xerox FreeFlow Copyright Management 
Server (CMS). This is described in Chapter 4. 

• Copyrights Clearance Center (CCC)—a third 
party, which provides the API for web based, 
automated ordering process, does copyrights 
Order Fulfillment. The CMS server implements this 
API and the Makeready uses CMS server for 
sending orders to CCC. These functions are 
internal mechanisms and not described in this 
guide. 

The system of copyright ordering and management, 
described in this guide, uses the following basic 
concepts: 
• Coursepack: A Coursepack is a file of type RDO 

(.rdo), which has been enhanced with copyrights 
specific functionality. The RDO is a Xerox format. 
The RDO files produced by “Makeready for 
Copyright Management” can hold contents 
(scanned images as well as PDF, TIFF, etc) of a 
coursepack as well as its metadata (Coursepack 
Title, Coursepack Number, etc). Each coursepack 
is further divided into sections, which hold 
copyright metadata (ISBN, Author, Title, etc.) for 
individual articles in a coursepack. 
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• Content Experts, define coursepack contents and 
the related metadata. Content experts are 
Professors, Instructors, Reference Librarians, etc. 

• Makeready Operators, enter contents and its 
related metadata in to the system and place 
orders for the copyrighted material. 

• Administrator maintains a working system; 
perform backend processes such as reporting, 
order cancellation, and guide operators. 

• CCC—Copyright Clearance Center (a third-party) 
provides copyrights permission clearance. The 
customer of this system must enter into 
appropriate agreement with directly CCC and 
obtain an account to be used by this system for 
order placement. 

The FreeFlow Makeready software with CMS Options 
is installed using one of two configurations: 
• CMS Server: In the CMS Server configuration, the 

CMS Server is also installed, including the 
Database and the Web server. The CMS “Reports 
and Management” User Interface is available only 
in this configuration. If the site is running only one 
FreeFlow Makeready with CMS, this is the 
configuration that should be installed. 

• CMS Client: In the CMS Client configuration, only 
FreeFlow Makeready is installed with client 
software that connects to an existing, previously 
installed CMS Server. The CMS “Reports and 
Management” is not available on the client 
machine, but is to be used on the CMS Server 
machine, which collects data for FreeFlow 
Makeready installed on both the CMS Server and 
CMS Client machine. 

NOTE: It is important to recognize that the CMS Client depends 
on the CMS Server machine. For successful operation, both 
machines should be operating and communicating correctly. 

NOTE: The RDO file contains all the document contents, as well 
as the copyright metadata; the CMS Server contains all the 
copyright order information and up-to-date status of the orders. 
This division allows document contents and order data to be 
stored and archived independently of each other. 
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System Diagram 

CMS Functions
Search and View Coursepacks
Export Coursepack Data
Coursepack Functions
- View Permission Summary
- View All Details
- Delete a Coursepack
Copyright Order Management
- Cancel Order/Delete Section
- Modify Quantity
Configure CMS
-CCC User Account Changes
- Network Connection Changes
- Test System Connectivity

Xerox FreeFlow
Makeready

Xerox FreeFlow
Copyright Management

Server (CMS)

MakeReady Functions
RDO Creation
RDO Print
Coursepack Functions
- Creation
- Copyrights Section Data Input
- Copyrights Order Placement
- Copyrights Order Status

Operator

Administrator

CCC Web
Site

 
 

Figure 1 FreeFlow Makeready and CMS Server Functions 
 

 

 
Figure 2 Functions of RDO and CMS Server Database 
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Copyrights/Coursepack Ordering 

The coursepack workflow should be as follows: 
1. Content Experts provide a list of articles and 

related copyright metadata to be included in a 
given coursepack. The copyright metadata 
includes ISBN, Article Title, Publication, 
Publication Year, etc. This information is provided 
to the print shop operator. 

2. Makeready Operators enter both document-level 
and section-level coursepack information in the 
Makeready application. Document-level and 
section-level properties present the Makeready 
Operator with several Copyright attribute fields 
that can be filled in to define the coursepack and 
facilitate copyright requests. (The Content Expert 
generally provides much of the information for 
each article that s/he wants included in the 
coursepack). This process might take a few 
minutes to several days depending on the size 
and complexity of the coursepack. During the input 
of the copyright information, the operator has an 
opportunity to perform a “Quick Price” on each of 
the “Section Properties” (that is, articles) within the 
given coursepack. The Quick Price activity 
validates whether the copyrights are available via 
the CCC. No order is registered with the system at 
this point.  

3. Once the coursepack is complete, with all the 
sections (that is, articles) required, the Makeready 
Operator places an order for the entire coursepack 
in the “Document Properties” page in Makeready. 
Once an order is placed, the FreeFlow CMS 
server records the coursepack data. From this 
point onward, the order data changes can be seen 
on the CMS UI. 
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Copyrights/Coursepack Modifications 

The following copyright order modifications are 
allowed: 
• Changing the number of permissions for all the 

sections in a coursepack. This function is 
performed at the FreeFlow CMS user interface. 

• Updating/Deleting a section/copyright in a 
coursepack. This function can be performed solely 
within the Makeready application if the copyright 
order has not been processed. If the order was 
previously placed, it requires action both at 
Makeready and the CMS UI. 

• Adding a section to an existing coursepack that 
has already been ordered is performed at the 
Makeready application. 
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3. FreeFlow Makeready for Copyright 
Management  

Xerox FreeFlow Makeready Copyright Management 
Service is a software application that you can use to 
enter documents that contain one or more pages that 
are protected under copyright permissions. The high-
level copyright summary information can be entered 
into the Makeready Document Properties and the 
copyright information can be entered into the Section 
Properties.  

This chapter contains the procedures for using the 
Makeready Copyright Management software on a 
workstation.  

Prerequisites 

The following prerequisites must be satisfied before 
using FreeFlow Makeready Copyright Management 
Service. 
• Make sure that FreeFlow Makeready is installed 

on the workstation. Refer to the Xerox FreeFlow 
Makeready Installation Guide for the procedures. 

• Know how to use Makeready functionality. Refer 
to the Xerox FreeFlow Makeready Installation 
Guide for the procedures Xerox FreeFlow 
Makeready Reference Guide for the procedures. 

• Make sure the license for the Copyright 
Management is valid. Refer to the FreeFlow 
Makeready System Administration Guide. 

• Make sure the Copyright Management Service is 
installed. Refer to the FreeFlow Makeready 
Copyright Management Service Install Guide. 
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Specifying the Copyright Management information in 
Makeready 

The following procedures are used with the 
Makeready application to create a coursepack. 

Using the Document Properties for Copyright Information 
1. Create or open a coursepack document in 

FreeFlow Makeready by selecting Insert > File or 
File > Open or File > New. 

2. Navigate to the desired document (TIFF, JPEG, 
PDF, ASCII, EPS, or PostScript file). 

3. Select Insert, or select File > Open. 
4. The .RDO opens in the FreeFlow Makeready 

application window. 

 
5. Next, select the topmost document icon to select 

the entire document: 
6. Right-click on the document icon, and select 

Document Properties from the drop-down. The 
Document Properties window opens. 
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7. Select the Copyright Summary tab. Refer to the 
definitions listed at the end of this section for 
details for each entry. 

8. Select the Specify copyright clearance 
information for the coursepack check box, if not 
already checked. Fill in the appropriate 
coursepack information for the coursepack you are 
creating. 

9. When you are finished, select OK to return to the 
document. 

 

Summary Coursepack Entries in Document Properties 
• Manage Copyrights checkbox – You must mark 

this check box to enable the other fields and 
buttons in this window. This check box also 
enables the Copyright tab to appear in the Section 
Properties. 

• Course Title – A required, user-supplied field that 
specifies the name of the coursepack. 
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• Course Number – A required, user-supplied field 
that specifies a number for the coursepack. 

• Department – A required, user-supplied field that 
specifies the name of the department requesting 
the coursepack. 

• Organization – A required, user-supplied field that 
specifies the name of the university requesting the 
coursepack. 

• Requester – A required, user-supplied field that 
specifies the name of the professor requesting the 
coursepack. 

• Requester Phone Number – An optional, user-
supplied field that specifies the phone number of 
the professor requesting the coursepack. 

• Requester E-Mail – An optional, user-supplied 
field that specifies the email address of the 
coursepack creator. 

• Usage Start Date – A required, user-supplied field 
that specifies the start date of the course. 

• Reference number – An optional, user-supplied 
field that specifies the account number of the 
professor requesting the coursepack. 

• Comment – An optional, user-supplied field used 
for any purpose. 

The list of buttons includes: 
• Quick Price – When this button is selected, all 

CCC-assisted sections (that is, Automatic and 
Research Order) are processed as if the Quick 
Price button was selected on each section 
property sheet. If any of the CCC-assisted 
sections contain ISBN, Total Pages, Start Page, 
End Page, or Number of Permissions fields that 
are empty or invalid, the operation is aborted. 
Further, the number of permissions requested will 
be updated in each of the Automatic and 
Research Order sections. 

• Order – When this button is selected, all 
Automatic and Research Order sections are 
processed as if the Order button was selected on 
each section property sheet. If any of the 
Automatic sections contain ISBN, Total Pages, 
Start Page, End Page, or Number of Permissions 



Copyright Management  FreeFlow Makeready for Copyright Management   

Copyright Management User Guide   3-5 

fields that are empty or invalid, the operation is 
aborted. Manual copyright sections will be skipped 
if the number of permissions in the section does 
not match the number of permissions being 
ordered. The operator is expected to go to each 
“Manual” section and place the order so it is 
recorded by the CMS Server. After this button is 
selected, a scrolling list of ‘Copyright Status’ boxes 
displays and requires the user to select OK. If the 
order is Granted, the result is stored in the Total 
Fees field of each section. If the order is either 
Pending or “Forwarded to Rights Holder,” the Total 
Fees field is set to zero. 

• Standard Terms and Conditions – Displays the 
standard terms and conditions set by the CCC. 
For each order, the specific terms and conditions 
are also recorded at the CMS Server. 

• Summary – When this button is selected, a status 
summary of each copyright displays in a scrolling 
list box that describes the title, ISBN, order status, 
permissions requested, and copies printed 
previously for each section with a non-blank ISBN 
within the document. 

• OK – Selecting this button preserves the changes 
made to the user input fields. 

• Cancel – Selecting this button discards the recent 
changes made to the user-input fields. 

Using Makeready Sections with Copyright Management 
Sections are convenient methods for delineating 
different articles that could make up the coursepack. 
Document sections are the only place in which to 
define individual copyright articles. If the document 
has previously been segmented (Tagged) into 
sections, proceed to the Section Properties for 
Copyright Information section below. Otherwise, 
follow the steps outlined here to create document 
Sections within the coursepack. 
1. At the Makeready document display screen, 

highlight one or more pages that represent the first 
section (such as, article) of the coursepack. 

2. Right-click on the page(s) and select Tag Section 
from the dropdown. 



FreeFlow Makeready for Copyright Management Copyright Management 

3-6  Copyright Management User Guide 

3. Type a name that describes the selected section 
in the Section Name window (such as, Chapter 1). 

4. Select OK. 
5. Repeat Steps 1 through 4 to define all the sections 

for the coursepack. 

Copyright Entries within Section Properties 
The following describes the copyright properties that 
display information and operator entries for the 
copyright attributes defined for the section. 
• Automatic, Manual, and Research Order radio 

buttons – These radio buttons determine the 
mode of operation. If selected, Automatic utilizes 
the copyright server to: 
• Place orders 
• Obtain quick price requests 
• Retrieve copyright information based on 

ISBN/ISSN 

When Automatic mode is selected, these use the 
CCC engine available at http://www.copyright.com/ to 
accomplish the above. In addition, several fields will 
be read-only to the user. When manual mode is 
selected, these fields should be filled out by the user 
so they appear in reports generated by the copyright 
server.  

The operator is also responsible for: 
i) Contacting the rights holder for orders. 
ii) Contacting the rights holder for quick price 

requests. 
iii) Retrieving copyright information based on 

ISBN/ISSN. 

The operator, of course, can still use 
http://www.copyright.com/ for items (ii) and (iii), but 
Xerox should not advertise this in the documentation. 
Note that if the user switches from automated to 
manual, the Order Status, Terms, and Conditions, 
and Total Fees fields will be cleared. 

If an ISBN number is not in CCC’s database or if, in a 
rare case, the ISBN has a duplicate entry, the 
Research Order radio button becomes available for 
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selection. In this case, the Operator should fill in as 
many fields as possible, and then place a Research 
order. 

However, for a Research Order, the Publication Year, 
Publication, Title, Author, and Publisher are required 
fields. Such an order is placed just like an Automatic 
order, but the CCC carries out research to check if the 
title is available for the permission. 
• International Standard Book Number (ISBN) or 

International Standard Serial Number (ISSN) – 
This is a unique number assigned to each 
published work that can be obtained from the 
copyrights page (usually a few pages after the 
front cover) or by browsing 
http://www.copyright.com/. 
This is a mandatory, user-input field for 
both manual and automatic modes. When 
copying the number from a published work, 
do not enter the dashes. If an order has 
been placed, and the ISBN number is 
changed, the Order Status, Terms and 
Conditions, and Total Fees will be cleared. 

• Publication Year – In Automatic mode, this field 
is a required, user supplied field. In manual mode, 
this is an optional, user-input field, for supplying 
the published year. 

• Date Of Issue – In Automatic mode, this field is a 
read only field, supplied by the copyright server. In 
manual mode, this is an optional user-input field 
for supplying the date on which the work was 
published. This is an important field for some 
serial and journal publications, and the availability 
of the permission might depend on this date. If the 
desired permission is not available, it is 
recommended that CCC be contacted for 
clarification. 

• Start page and End page – These are required 
fields used by the Quick Price and Order 
calculations when Automatic and Research Order 
is selected; they are optional fields when Manual 
is selected. If the work lacks page numbers, 
simply enter spaces or contact the CCC. Note also 
that page numbers can be specified in a variety of 
formats, including Arabic and Roman. 
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• Number of Permissions – This user-supplied 
field is required by the Quick Price and Order 
calculations. Note that the number specified by the 
user is not consolidated with all previous orders; 
the resulting order status and fees apply only to 
the most recent order. Example: Suppose the user 
orders three permissions from the document 
properties after ordering five permissions from the 
section property sheet. When the user selects 
“Update”, they receive status on only the most 
recent order for three permissions. This policy 
applies regardless of which property sheet was 
used to place the order. In this example case, it 
is expected that the user contacts the CMS 
Administrator and requests to “cancel” order 
of the previous five permissions. 

• Total pages – This is a user-supplied field 
required by the Quick Price and Order 
calculations. This specifies the total number of 
pages being used in the coursepack, not the total 
pages in the work. 

• Reference Number – This field is sent along with 
the order (Automatic and Research Order) to the 
CCC web site and is expected to be used for order 
and invoice reconciliation purposes. Thus, 
although it is not a required field, it is 
recommended that its value be chosen carefully. 

• Total Fees – In Automatic mode, this field is a 
read only field, supplied by the copyright server 
during Quick Price and Order operations. In 
automatic mode, this field is not preserved after 
the user closes the window. The user must 
regenerate the total fees using the Quick Price, 
Order, or Update buttons. In Manual mode, this is 
a required user-input field for supplying the cost of 
the rights desired by the operator. In Research 
Order mode, this field is set to zero on order; if the 
order is later “Granted,” its updated value can be 
obtained using the “Update” button. 

• Order Status – In Manual mode, this field is a 
blank read-only field. In Automatic and Research 
Order mode, this field is blank until an order has 
been placed. After an order has been placed, it 
contains one of the following states: 
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− Granted – Permissions are available for the 
work. 

− Denied – Permissions are not available for the 
work. 

− Cancelled – The request for permissions was 
cancelled from the copyright service. 

− Contact Rights Holder Directly – The CCC 
cannot give permissions from the Rights holder, 
but the user can try directly. 

− Public Domain – No permissions are required 
to reprint the work. 

− Special Order – The CCC requires you to 
submit a special order prior to the CCC’s 
contacting the Rights Holder. 

− Forwarded to Rights Holder – The CCC has 
sent the rights request to the Rights holder. 

− Pending – The CCC has not sent the rights 
request to the Rights holder yet. 

NOTE: The date and frequency with which orders are invoiced 
depend on the user’s billing arrangement with the CCC. At the 
end of each billing cycle, all Granted orders become invoiced.  
For this reason, Granted can be considered a transitory state, 
not a final state. All the states listed above are final states except 
for Granted, Special Order, Forwarded to Rights Holder, and 
Pending. Granted has already been explained, but the other 
three states must eventually be replaced by one of the following 
states: Granted, Denied, Cancelled, or Contact Rights Holder 
Directly. Furthermore, Special Order may be replaced by 
Forwarded to Rights Holder or Pending before being resolved in 
a final state. 

• Publication – In Automatic mode, this field is a 
read-only field supplied by the copyright server. In 
Manual and Research Order mode, this is a 
required user-input field for supplying the title of 
the work. 

• Title – In Automatic mode, this field is a blank 
read-only field that can be used in future releases. 
In manual mode, this is an optional field intended 
to hold the name of the article or chapter in a 
publication. In Research Order mode, this is a 
required user-input field. 

• Author – In Automatic mode, this field is a read-
only field, supplied by the copyright server. In 
manual mode, this is an optional user input field 
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for supplying the name of the author. In Research 
Order mode, this is a required user-input field. 

• Volume – In Automatic mode, this field is a read-
only field, supplied by the copyright server. In 
Manual and Research Order mode, this is an 
optional user-input field for supplying which 
volume is being referenced. 

• Edition – In Automatic mode, this field is a read-
only field, supplied by the copyright server. In 
Manual and Research Order mode, this is an 
optional user-input field for supplying the edition of 
the work. 

• Publisher – In Automatic mode, this field is a 
read-only field, supplied by the copyright server. In 
manual mode, this is an optional user-input field 
for supplying the name of the publisher. In 
Research Order mode, this is a required user-
input field. 

• Copyright Owner – In Automatic mode, this field 
is a read-only field, supplied by the copyright 
server. In Manual and Research Order mode, this 
is an optional user-input field for supplying the 
name of the rights holder. 

The list of buttons will include: 
• Quick Price – This button is disabled when 

Manual or Research Order mode is selected. If 
Automatic mode is selected, the copyright server 
uses the CCC API to provide the same 
functionality as the Quick Price functionality 
available on http://www.copyright.com/. The 
required fields for this operation are ISBN, 
Publication Year, Start Page, End Pages, Total 
Pages, and Number of Permissions. The result is 
placed in the Total Fees field. After this button has 
been selected, a scrolling Terms and Conditions 
list box displays and requires the user to scroll to 
the bottom of the text before OK can be selected. 

• Order – If Automatic or Research Order mode is 
selected, and a Quick Price has been selected for 
the current ISBN, the copyright server uses the 
CCC API to provide the same functionality as it 
would if a logged-in user places an order on 
http://www.copyright.com/. After this button is 
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selected, the Terms and Conditions are enabled. If 
the order is Granted or Invoiced, the result is 
stored in the Total Fees field. Once an order has 
been placed, the order button is grayed out. For 
Manual mode, ISBN/ISSN, Number of 
Permissions, Total Pages, and Total Fees are 
required fields. 

• Terms and Conditions – This button is disabled 
when either Manual mode or Research Order is 
selected. If Automatic mode is selected, and a 
Quick Price has been requested or an order has 
been placed, the button is enabled. Selecting the 
button results in FFMR displaying the same text 
provided when Terms and Conditions is selected 
after the user places an order on 
http://www.copyright.com/. Note that this text is 
always generated dynamically; it is not stored. 

• Update – This button is disabled when Manual 
mode is selected. If Automatic or Research mode 
is selected, and an order has been placed, it is 
enabled. When this button is selected, the 
software provides the most up-to-date Order 
Status, Terms and Conditions, and Total Fees on 
the most recent order. This policy applies 
regardless of which property sheet was used to 
place the order. 

• OK – Selecting this button preserves the changes 
made to the user input fields. 

• Cancel – Selecting this button discards the 
changes made to the user-input fields  

Defining Section Properties for Automatic Order Mode 
From the Makeready document display screen, select 
the first section in which copyright information will be 
added or managed, and follow the steps below. The 
user fields in this window are explained in detail at the 
end of this section. 
1. Right-click on the Section icon, and select 

Section Properties from the drop-down. 
2. Select the Copyright tab to display the Copyright 

properties for this section. 
3. Mark the Specify copyright clearance information 

for this section check box, if not already marked. 
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4. Select Automatic as the Mode of Operation. 
5. Enter the ISBN/ISSN number for this section. 
6. Enter the Start Page and End Page numbers from 

the copyright material being managed. These 
page numbers correspond to the page numbers in 
the original copyrighted document.  
For example: Start Page 23, End Page 32. (These 
do not correspond to the page numbers in the 
Makeready document.) 

7. Enter the Number of Permissions requested for 
this material. 

8. Enter the Total Number of Pages for which the 
permissions are being requested.  
For example, for Start Page 1 and End Page 2, 
the Total Number of Pages is 2. This number of 
pages must be correct for Quick Price operation. 

9. Proceed to Section Level Quick Price. 
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Defining Section Properties for Manual Mode 
1. Right-click on the Section icon, and select 

Section Properties from the drop-down. 
2. Select the Copyright tab to display the Copyright 

properties for this section. 
3. Mark the Specify copyright clearance information 

for this section check box, if not already marked. 
4. Select Manual as the Mode of Operation. 
5. Enter the ISBN/ISSN number for this section and 

all other available information. 
6. Enter the Start Page and End Page numbers from 

the copyright material being managed. These 
page numbers correspond to the page numbers in 
the original copyrighted document.  
For example: Start Page 23, End Page 32. (These 
do not correspond to the page numbers in the 
Makeready document.) 

7. Enter the Number of Permissions requested for 
this material. 

8. Enter the Total Number of Pages for which the 
permissions are being requested.  
For example: For Start Page 1 and End Page 2, 
the Total Number of Pages is two (2). This number 
must be correct for Quick Price operation. 
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9. Proceed to Order Copyright Permissions at the 
Section Level. 

 

Defining Section Properties for Research Order Mode 
1. Select the Section icon. 
2. Right-click and select Section Properties from 

the drop-down. 
3. Select the Copyright tab to display the Copyright 

properties for this section. 
4. Mark the Specify copyright clearance information 

for this section check box, if not already marked. 
5. Select Automatic as the Mode of Operation. 
6. Enter the ISBN/ISSN number for this section and 

all other available information. 
7. Enter the Start Page and End Page numbers from 

the copyright material being managed. These 
page numbers correspond to the page numbers in 
the original copyrighted document.  
For example: Start Page 23, End Page 32. (These 
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do not correspond to the page numbers in the 
Makeready document.) 

8. Enter the Number of Permissions requested for 
this material. 

9. Enter the Total Number of Pages for which the 
permissions are being requested.  
For example: For Start Page 1 and End Page 2, 
the Total Number of Pages is two (2). This number 
must be correct for Quick Price value to be 
correct. 

10. Proceed to Quick Price at the Section Level. 

NOTE: If the Order Status is “Work Not Found” or, in rare 
instances, “Duplicate Works,” then the Research Order radio 
button becomes available, as shown below. 
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11. If you wish to place an order with the CCC for this 
work, select Research Order (note that Quick 
Price is not available in this mode), provide values 
for as many fields as available, and proceed to 
Order Copyright. 
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Summary of Required Fields 
The following table provides a summary of required 
fields in different ordering modes. 

 
Reference notes for required fields: 
• The ISBN/ISSN value cannot be blank; if the 

information is not known, then dummy information 
should be used. 

• The publication year must be between 1000 and 
3000. Also, for some titles the copyright 
permission availability and price could depend on 
the year. 

• The correct Date of Issue is important for serial 
publications such as newspapers, magazines, and 
journals, since the copyright permission availability 
and price could depend on this date. 
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Section Level Quick Price 
Prior to an order being placed with the Copyright 
Clearance Center (CCC), the operator must request a 
Quick Price for the article. The Quick Price 
establishes whether the article is managed in the 
CCC database or in the public domain, or whether a 
more extensive search is required to obtain 
permission from the rights holder. 

 
Select Quick Price. After a short period, the request 
sent to the CCC returns information about the 
requested material. Listed below are the possible 
return statuses for a Quick Price operation: 
• Granted – Permissions are available for the work. 
• Denied – Permissions are not available for the 

work and an order cannot be placed with the CCC. 
• Cancelled – The request for permissions was 

cancelled from the copyright service. 
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• Contact Rights Holder Directly – The CCC 
cannot give permissions from the Rights holder, 
but the user can try directly. 

• Public Domain – No permissions are required to 
reprint the work. 

• Special Order – The CCC requires you to submit 
a special order prior to the CCC’s contacting the 
Rights holder. 

• Forwarded to Rights Holder – The CCC has 
sent the rights request to the Rights holder. 

• Pending – The CCC has not sent the rights 
request to the Rights holder yet. 

Order Copyright Permissions at the Section Level 
If the Total Fees for the article and the Terms and 
Conditions returned via the Quick Price operation are 
acceptable, perform the following steps. 
1. Select Order. 
2. If the information returned or the Fees are not 

acceptable, select Cancel.  
No permissions will be granted. 
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With the Order Status of Ready to Order, the article 
may now be ordered from the Copyright Clearance 
Center. 
1. Select Order. 

The screen below indicates the order was 
granted.  

 
You can make changes in this window. If a 
field is altered, the Order Status 
immediately changes to Awaiting Quick 
Price, and all buttons are grayed out. The 
operator must request a Quick Price to 
update the new information.  

2. Complete the steps to order from the CCC. 

NOTE: If changes must be made on an existing “Granted,” 
“Pending,” or “Forwarded to Copyrights Holder” order, the 
current order must be cancelled from the CMS Administrator’s 
UI. Otherwise, the existing order might remain in place and the 
CCC will invoice the same. 
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Order Copyright Permissions from Document Properties 
Copyright permissions can be ordered from the 
Document Properties level. When this is performed, 
all articles in the coursepack are submitted to the 
Copyright Clearance Center. 

NOTE: If any section has an existing order that is “Granted,” 
“Pending,” or “Forwarded to Copyrights Holder,” then such 
orders should be cancelled from the CMS Administrator UI. 
Right-click on the top level document icon in the Document 
Structure window in Makeready and Document Properties > 
Copyright Summary from the drop-down. 
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10. Select Apply, and select OK. The CMSGroup has 
been created. 
Next, you will add another domain user(s) 
under whose permission the CMS Client 
will be running on the client machine. In the 
example window shown below, such a user 
is usx11860. 

11. Select Apply, and select OK.  
Creation of the CMSGroup is complete. 

Configure DCOM security properties as well as configure 
DCOM access rights for CMSGroup 

1. From the Start menu, select Run. The Run 
window opens. 

2. Enter <dcomcnfg> in the Open field, as shown 
below. 

 
3. Select OK. The Component Services window 

opens. 
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4. Select the Component Services node in the left 
pane, and click the + [plus] sign next to 
Computers. The My Computer icon appears. 

 
5. Right-click on My Computer and select 

Properties from the dropdown. The My Computer 
Properties window opens.  
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6. Select the Default Properties tab, and select the 
settings shown in the following illustration.  
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7. Select the COM Security tab, and then click the 
Edit Limits button under Launch and Activation 
Permissions. The Launch Permission window 
opens. 

 
8. Click the Add button, and select the CMS Server 

machine name by clicking on the Locations 
button. In the following illustration, the server 
machine’s name is 239Q581.  

 
9. Select the server machine, and select OK. The 

Select Users or Groups window opens.  
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10. Enter <Xerox FreeFlow Copyright Management 
Service Search Users>, the newly created group 
name, in the Enter the object names to select 
field.  

11. Select OK. The group is added to the Launch 
Permission.  

12. Mark all the check boxes under Allow in the 
Permissions for CMSGroup field. Select OK to 
close this window.  

13. On the COM Security tab, select the Edit Limits 
button under Access Permission. The Access 
Permission window opens.  
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14. Select the Add button to add the group Xerox 
FreeFlow Copyright Management Service 
Search Users to the Group or user names list. 
Use the same steps you took to add the group to 
the Launch Permission. Mark all the check boxes 
under Allow, as shown below.  

 
15. Select OK to close this window.  
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16. Open the Component Services window, and 
locate the CCMSvr server, as shown below.  

 
17. Right-click on CCMSVr and select Properties 

from the drop-down. The CCMSvr Properties 
window opens.  
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18. In the Authentication Level drop-down, select 
Connect.  

 
19. Select the Security tab.  
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20. Select the Customize radio button under Launch 
and Activation Permissions, and select the Edit 
button. The Launch Permission window opens.  
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21. Select the Add button to add Xerox FreeFlow 
Copyright Management Service Search Users 
to the list. Mark all the check boxes under Allow, 
and select OK.  

 
22. Select OK to close this window.  
23. Select the Customize radio button under Access 

Permissions, and select the Edit button.  
24. Add the CMSGroup to the Group or user names 

list, and mark all the check boxes under Allow.  
25. Select OK to close this window.  



Multiple CMS Client Configuration  Copyright Management  

8-16  Copyright Management User Guide 

26. Select the Identity tab, and select the This user 
radio button. Enter the user name and password 
for the Domain user under whose permission the 
CMS Server will be running. In the illustration 
below, the user is usx02592.  

 
27. Select Apply and select OK to close all windows.  

Configure the firewall for DCOM communications to CMS 
Service 

1. Select Start > Control Panel. 
2. Double-click on the Windows Firewall icon. The 

Windows Firewall window opens. 
3. Select the Exceptions tab. 
4. Select Add Port. The Add a Port window opens. 
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5. Fill in the DCOM in the Name text box and Port 
number fields as shown below.  

 
6. Select OK. The DCOM check box is marked, as 

shown below.  

 
7. Select OK. This adds the DCOM port to the 

Windows firewall exceptions list.  
8. Select Start > Settings > Control Panel, and 

then double-click on the Windows Firewall icon. 
The Windows Firewall window opens.  
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9. Select the Exceptions tab.  

 
10. Select the Add Program button. The Add a 

Program window opens.  

 
11. Click the Browse button.  
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12. Locate the CCMSvr.exe file in the E:\freeflow 
directory.  

 
13. Select the Open button. This adds CCMSvr.exe to 

the Add a Program window, as shown below.  
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14. Select OK. The CCMSvr.exe file is added to the 
Windows Firewall Exceptions list, as shown below.  

 
15. Select the General tab, select the On radio button, 

and select OK to enable the firewall.  
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16. Close the Control Panel window. The CMS Server 
configuration is now complete.  

17. Restart the server machine.  

CMS Client Machine (Makeready station) Configuration 
1. Select Start > Run. 
2. Enter <dcomcnfg> in the Open field, and select 

OK. The Component Services window opens. 

 
3. Click Component Services in the left pane. Click 

on the + sign next to Computers to show My 
Computer.  
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4. Right-click on My Computer and select 
Properties from the dropdown.  
The My Computer Properties window 
opens. 

 



Copyright Management  Multiple CMS Client Configuration   

Copyright Management User Guide   8-23 

5. Select the Default Properties tab, and ensure 
that the Enable Distributed COM on this 
computer check box is marked, as shown below.  

 
6. Open Windows Explorer. Locate the file CRApi.ini 

under C:\windows\. 
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7. Open the file CRApi.ini as text format.  
See the following: 
[CRApi] 
CRApiConnection=13.141.44.95 

8. Change the value of CRApiConnection. Make it 
point to the IP Address of where the CCMSvr is 
running. In the above example, the IP address of 
the CCMSvr is 13.141.44.95. 

9. Save the CRApi.ini, and close the Windows 
Explorer window. 

The CMS Client configuration is complete. You are 
ready to test the CMS Client working with the CMS 
Server. The best way to test it is by using “Quick 
Price” on the Makeready of the client machine. 
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Independent Workgroup Based Configuration 

Configure DCOM security properties as well as configure 
DCOM access rights for “Anonymous Logon” 

1. Select Start > Run. 
2. Enter <dcomcnfg> in the Open field. 

 
3. Select OK. The Component Services window 

opens.  

 
4. Select the Component Services node in the left 

pane, and then click on Computers. My Computer 
appears. 
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5. Right-click on My Computer and select 
Properties. The My Computer Properties window 
opens. 

 
6. Select the Default Properties tab.  
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7. Select Connect from the Default Authentication 
Level drop-down. Select Identify from the Default 
Impersonation Level drop-down. 

 
8. Select the COM Security tab.  
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9. Select the Edit Limits button under Launch and 
Activation Permissions. The Launch Permission 
window opens.  
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10. Select Add. Select the Advanced button in the 
window that opens to find the ANONYMOUS 
LOGON user name.  

 
11. Select OK to add the ANONYMOUS LOGON to 

Select Users, Computers, or Groups.  
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12. Select OK to add the ANONYMOUS LOGON to 
the Group or user names list. Mark all check 
boxes under Allow, as shown below.  

 
13. Select OK to close the Launch Permission 

window.  
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14. Select the Edit Limit button under Access 
Permissions.  

 
15. Select Add to add the ANONYMOUS LOGON to 

the Group or user names list.  
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16. Mark all the check boxes under Allow in the 
Permissions for ANONYMOUS LOGON area, as 
shown below.  

 
17. Select OK to close the window of My Computer.  
18. Open the Component Services window. Click 

Component Services, click Computer, and click 
My computer.  
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19. Click DCOM Config, and locate CCMSvr.  

 
20. Right-click on CCMSvr, and select Properties. 

The CMSvr Properties window opens.  
21. On the General tab, select None from the 

Authentication Level dropdown.  
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22. Select the Location tab, and make selections as 
shown below.  

 
23. Select the Security tab. Select the Customize 

radio button under Launch Permissions, and click 
Edit.  
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24. In the Launch Permission window, add the 
ANONYMOUS LOGON user to the Group or user 
names list by completing the same steps you took 
to add the ANONYMOUS LOGON to the 
Computer level. Mark all check boxes under Allow, 
as shown below.  

 
25. Select OK to close the Launch Permission 

window.  



Multiple CMS Client Configuration  Copyright Management  

8-36  Copyright Management User Guide 

26. Select the Security tab again. Select the 
Customize radio button under Access Permission, 
and click Edit.  
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27. In the Access Permission window, add the 
ANONYMOUS LOGON user to the Group or user 
names list, and mark all the check boxes under 
Allow.  

 
28. Select OK to close the Access Permission 

window.  
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29. Select the Identity tab. Select the This user radio 
button, and enter the User name and Password 
under whose account the CCMSvr will run.  

NOTE: Make sure that this user has installed the Makeready and 
CMS Service, or that this user has the access rights to run both 
Makeready and CMS Service. 

 
30. Select Apply and OK to close all windows of 

Component Services.  
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Configure the Firewall for DCOM communications to CMS 
Service. 

1. Select Start > Settings > Control Panel.  
2. Double-click on the Windows Firewall icon. The 

Windows Firewall window opens. 
3. Select the Exceptions tab. 

 
4. Select Add Port. The Add a Port window opens.  
5. Enter <DCOM> in the Name field and <135> in the 

Port number field, as shown below.  
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6. Select OK. The Windows Firewall window opens. 
Note that the DCOM check box is marked.  

 
7. Select OK. This adds the DCOM port to the 

Windows firewall exceptions list.  
8. Select Start > Settings > Control Panel.  
9. Double-click Windows Firewall icon. The 

Windows Firewall window opens.  
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10. Select the Exceptions tab.  

 
11. Select Add Program. The Add a Program window 

opens.  
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12. Click the Browse button. In the Browse window, 
locate and select the file CCMSvr.exe in its 
directory (for example, E:\FreeFlow).  

 
13. Select Open. This adds CCMSvr.exe to the Add a 

Program window list.  
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14. Select OK. This adds CCMSvr.exe, which its 
check box marked, to the Windows Firewall 
Exceptions list. 
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15. Select the General tab. Select the On radio 
button.  

 
16. Select OK to enable the firewall. 
17. Close the Control Panel window. The server 

configuration is now complete. 
18. Restart the server machine. 

Configure DCOM security properties on the CMS Client 
machine 

On the Client Machine: 
1. Select Start > Run. 
2. Enter <dcomcnfg> in the Open field, and select 

OK.  

 
3. In the Component Services window, select the 

Component Services node in the left pane, and 
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click the + sign next to the Computers folder. The 
My Computer icon appears.  

 
4. Right-click on My Computer and select 

Properties from the dropdown. The My Computer 
Properties window opens.  

5. Select the Default Properties tab. Mark the 
Enable Distributed COM on this computer 
check box, if it is not already marked. 

 
6. Select Apply and select OK to close all windows.  
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7. Open the file CRApi.ini as text format.  
See the following: 
[CRApi] 
CRApiConnection=13.141.44.95 

8. Change the value of CRApiConnection. Make it 
point to the IP Address of where the CCMSvr is 
running. In the above example, the IP address of 
the CCMSvris 13.141.44.95. 

9. Save the CRApi.ini and close the Windows 
Explorer window. 

10. Now the client’s machine configurations steps are 
completed. 

Repeat the same process for each CMS Client 
machine.



 

 

9. Appendix: Field Names and Usage 

• Course Title – User-entered title of the course. 
This title is the title of the coursepack. 

• Course Number – User-entered number for the 
course. 

• Course Start Date – User-entered start date when 
pages having copyright protection will be 
distributed. This could be the start of the semester 
for a university or college. 

• Requestor Name – User-entered name of the 
person requesting this document. 

• Requestor Phone – User-entered phone number 
of the person requesting this document. 

• Requestor Email – User-entered email of the 
person requesting this document. 

• Organization – User-entered organization of the 
person requesting this document. 

• Department – User-entered department of the 
person requesting this document. 

• Comment – User-entered comments. 
• Operator name – Person who was logged in at the 

Makeready at the time of creation of this 
coursepack. 

• Reference Number – User-entered number that 
will be associated with this document. 

• Status – Status of the document. The status can 
be NEW or DELETED (the user has canceled this 
coursepack but has not removed it from the 
database). 

• Creation Date – Date of creation using FreeFlow 
Makeready. 

• Modification Date – date of last modification. 
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• Section Details: The following information is 
provided for each section in the document. 

• Record Status – This section may be New or 
Deleted. 

• Order Status – The status can be granted, denied, 
pending, contact rights holder directly, or ordered 
(for manual orders). 

• Manual Order – Yes or no where yes represents 
user-supplied copyright information. On 

• Makeready, the Manual Order radio button is 
selected. 

• Customer Reference Number – User-entered 
number that will be associated with this section. 

• ISBN/ISSN number – Unique identifier for this 
section. 

• Article Name – Title of this section 
• Publication Title – Title of the publication from 

which this section was derived. 
• Publisher – Publisher of the publication. 
• Publication Year – Publication year of the 

publication. 
• Author – Author or editor name for the publication. 
• Date of Issue – Date of issue for the publication. 
• Volume number – volume number for the 

publication. 
• Edition – Edition of the publication. 
• Total Pages – Number of total pages in this 

section that have copyright protected information. 
• Start page – Page number of first page of the 

section that has copyright protected information. 
• End Page – Page number of the last page of the 

section that has copyright protected information. 
• Order Placed Date – Date the order was selected 

by the user on Makeready. 
• Order Completed Date – For those orders that 

require processing, the date that the response for 
that order request was received. For Manual 
Orders, it is the date Order was selected by the 
user on Makeready. 
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• Creation Date – Date the Section was created and 
OK was on Makeready. 

• Modification Date – Last date the order was 
modified. 

• Order Head ID – References identifiers provided 
by the Copyright Clearance Center for tracking 
that order. 

• Order Detail ID – References identifiers provided 
by the Copyright Clearance Center for tracking 
that order. 

• Rights holder – Owner of the rights for the pages 
containing copyright protected information. 

• Terms and Conditions that associated with the 
permissions allowable for using the pages 
containing copyright protected information. 

• Number of copies ordered – The number of 
permissions ordered for using the pages 

• containing copyright protected information. 
• Number of copies printed – Number of sets for 

which Makeready print requests have been 
requested for this section. 

• Last Printing Date – Date of the last Makeready 
print request for this section. 

• Total Fee – User-entered fees for the number of 
permissions secured for the pages that contain 
copyright protected information. This is for manual 
orders. Copyright Clearance 

• Center provided fees for all granted orders. This is 
for automatic orders. 

• Cancellation Fee – Copyright Clearance Center 
provided fees for all cancelled orders. This is for 
automatic orders. 



 

 

 




